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From the President

to you all,

Morning Sessions
Monday, Wednesday and Friday

10.00 am to 12 noon

SeniorNet Mac Inc. PO Box 475

Christchurch 8140

41 Essex Street, Christchurch

Web: http://seniormac.org.nz/

The SeniorNet Mac Apple NEWS is distributed

bimonthly on 10th April, June, August, October,

December and February. You will be kept updated on

important matters with a Mini Newsletter by email

every week, in between times.

P
If you need to bring in your computer please ring:

03 365 1979

and leave a message

Items that can be solved quickly will be $5 but

problems requiring significant time will attract up

to $20 workshop charge.

op in and have a cuppa in the learning

centre. You can get answers to computer

problems, ask questions and get advice.

Afternoon Session
Wednesday, 1.00 pm to 3.00 pm

can’t believe how fast this year is going and I heard

someone on the radio say how many weeks till

Christmas. I told them to get lost I am not ready for that!
I

We had a great turnout for our SeniorNet Social at our new

Venue The Borough (The Richmond Club). What a super huge

new Venue to be able to have our socials there. The food was

excellent and the staff were so helpful a pleasure to go there.

The next two months we are going to have two excellent

speakers so do try to make the effort to come along and support

us. We do try to get interesting speakers for our socials so being

a member is worth your while.

June's speaker, Sonali Chandratilake, is a coordinator from Civil

Defence Emergency Management team at the Christchurch City

Council; this should be very interesting, especially for us here as

we have a severe weather warning in place today.

July we have Miracle Tarawa, a former member of the Gloriavale;

she will discuss her life inside. Mark these dates in you Calendar

as I'm sure they will both be very interesting. We are very lucky

having Erika White seeking these interesting speakers for us; so

do come along as she works very hard to find these for us.

I do hope you have updated your devices as there have been

quite a few updates recently all to do with the privacy act and

you must do these.
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Welcome to New Members

Page

everyone

Glenda Turner and Clare Milne, Nick Williams.

J une and half the year has gone. I certainly hope that

you have survived the recent deluge that swamped

the Canterbury region. What a turmoil the world

seems to be in—widespread Covid19, Polical upheaval,

Dramatic Climate Change, Volcanic Eruptions, Earthquakes

etc. This issue of Apple NEWS features Spring loaded,

Apple's May announcement of their New Product Range.

They have a very cunning logo to go with that announcement

—the Apple designed as a Spring. This month instead of the

usual Apple symbol signifying the end of an article I have

used the Spring loaded symbol. Cookin' with Apple now has a

page of it's own, Pam Doughty has more "Tips" and Brian the

Pirate has some "Tech Humour". Apple's new products are

listed over several pages. The new iMac is reviewed, Apple

Air Tags are also reviewed. Impressions features Apple TV 4K

and Siri. August/September Apple NEWS will have a new

layout and look. The existing layout and design of some

pages has become cluttered and unmanageable; it was

originally designed 6 years ago when I needed to keep to 16

pages and be aware that the content had to be suitable for

reproducing in black and white. Now that it's only produced

Digitally I no longer have those constraints. Please, Please,

Please scan—I can not believe how blasé people have

become—they walk straight past the codes for scanning—

we can not be blasé—look at the resurgence of the virus in

the community in Victoria, Australia!! So until next time,

keep warm, safe and be kind. Auf Wiedersehen
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IMPORTANT
INTERNET BANKING

Our Direct banking number is 020816-0376043-00

PLEASE when paying monies to SeniorNet Mac, include as

reference either your Name or Membership Card number.

We are receiving credits from time to time from unknown

members. We have no way of telling who they are from.

Your Membership Number is a unique number and has 4 digits

begining with the figure 4

Elizabeth Chesney

Treasurer@seniormac.org.nz

Apple User Group
Canterbury Apple Users

is a subgroup of Christchurch SeniorNet Mac Inc. and
meets on the last Wednesday of each month at

7.30 - 9.30pm in the SeniorNet Mac Rooms,

41 Essex Street, Christchurch.

A heated room with all conveniences, tea/coffee and bikkies.

FREE to SNM members. General public $4.00

Meetings will disscuss users' problems and review recent

announcements and news relating to Apple products. All welcome. 
�

Deadline
Deadline for August/SeptemberApple NEWS

28th July 2021

Please have your copy for the next Apple NEWS to me

by the above date.

Copy can be either typed straight into an email, as a

Word file or as Rich Text Format.

Digital images need to be at least 220dpi or higher

(72dpi will not reproduce well)

Please no hard returns except at the end of a

paragraph.

DEADLINE SeniorNet Mac Inc.

Christchurch Learning Centre

Our Privacy Policy
• We collect information for lawful purposes so we

can communicate with our members. We collect

information so we can ensure we are providing you

with relevant courses, news about technology and

invitations to events.

• We also provide demographic information to our

funders, sponsors and to government agencies but

this information does not include personal

identification. While we appreciate this

demographic information, it is not compulsory to

provide it.

• We may share your contact information with our

national body, The Federation of New Zealand

SeniorNet Societies Inc, so that in the event of the

closure of our Learning Centre, for any reason, we

can keep in touch.

• Wewillbehappytoshowyouwhatever information
wehaveaboutyouonourmembership filesandwe
willendeavour tokeepthat informationuptodateat
yourrequest.

Our Sponsors

Also in association with:

The Federation of NZ SeniorNet Societies
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SeniorNet Mac

41 Essex Street

We can
HELP

email:

bookings@seniormac.org.nz

Need

tuition?

Need

to upgrade

your Apple

Device?

Want

to know more

about

Apple TV?

Need

help with

Online

Banking?

How to use

Skype and

Face Time?

New to

Apple Devices

and

Programmes?

How to

stay safe and

not be

Scammed?

What is

iCloud and

Dropbox?
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Cookin’ with
Zugedeckter Apfelkuchen

(German ‘Covered’ Applecake, from Dr Oetker Baking Book)

Pastry

300g self-raising flour (or plain flour with 2t baking powder)

100g caster sugar

1t vanilla essence

1 egg

1T milk

150g butter at room temperature, chopped into small pieces (or margarine)

Pulse everything except egg & milk in food processor until mixed. Add egg and milk, and

blend till all mixed in. Remove from processor and knead into a dough ball. Cover with

gladwrap and place in fridge whilst preparing filling.

Filling

1kg (4 large) granny smith apples, coarsely grated

2 – 3T caster sugar

½ t cinnamon

¼ t ground cloves

2T raisins/ nuts

Place grated apple in pot and simmer on low heat for about 5 minutes. Add the rest of the

ingredients and fold in, taking care not to make apples too mushy. Set aside to cool while

preparing base.

Roll ½ the dough into a shape to line round cake tin (26cm), with some dough going a short

way up the sides of tin. Prick with a fork, and bake ‘blind’ in oven at 180 deg C for 10-15

minutes. Roll remaining half of dough to form the top of the cake, slightly oversized to

cover mixture and fold down at edges. Spoon apple mixture into the pastry-lined cake tin,

(spread ~ 2 tsp of breadcrumbs over cooked base) taking care not to pour too much of the

juice created from the apples. Cover the top with the rolled dough, folding and pressing at

edges to seal. Prick with a fork, and brush with topping mixture. Make pattern by gliding

back of fork criss-cross over top.

Topping mixture

½ egg yolk

1T milk

Place in oven at 180 deg C for 20-25 minutes, until golden.

Serve, hot or cold, with whipped cream or ice cream.

Recipe courtesy of
SeniorNet Mac member Erika W

hite.
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Newshub 28/4/2021

MOBILE PHONES

Apple's iOS 14.5 update delivers

new privacy controls, emoji

updates

Mike Kilpatrick

APPLE UPDATES

Photo credit: Apple

Apple's major software update for iPhones, iOS 14.5,

has been released, giving Kiwis more control over

their online privacy and introducing new, updated

emojis, among other features.

The kissing couple and couple with heart emojis have been

updated to allow different skin tones to be selected for each

individual. Emojis including a woman with a beard, a mending

heart, a face exhaling and a heart on fire also make their debut.

Photo credit: Apple

Meanwhile the much talked about App Tracking Transparency

feature, first announced by Apple last year, means users must

now give explicit permission for apps to track them across

other apps and websites for advertising purposes.

This will be done via individual notifications in apps when first

used post-installation, or can be switched off by default in the

Privacy > Tracking setting. Users will also be able to see

which apps have requested permission, so choices can be

changed at any time.

Erratum
A publishing error occured in Apple NEWS April/May.

In the Article "I Remember When" the first Memory

was attributed to Carol White instead of Clare White.

The Editor sincerely regrets this error and accepts full

responsibility.

Film Review

BAFTA Awards 2021
Best Actress: Frances McDormand

Best Director: Chloé Zhao
Best film 2020, Best Cinematography.

2021 Oscars
Best Actress: Frances McDormand

Best Director: Chloé Zhao

Best Picture.

Highly recommended viewing—Editor

The move has been criticised by Facebook, which says personalised

ads help support small businesses and keep apps free.

A spokesperson for the social media platform told Newshub

earlier this year: "Apple's new prompt is designed to present a

false trade-off between personalised ads and privacy when in

fact, we can provide both."

Other new features in iOS 14.5 include the ability to unlock your

iPhone with the Apple Watch when you're wearing a face mask,

Siri enhancements to help with diversity and inclusion, and

support for the newly announced AirTags.

The new update will be downloaded automatically if you have

auto-updates switched on, otherwise go to Settings > General>

Software Update to install.

https://www.newshub.co.nz/home/storytag.:storyTag=newshub:tag-library___mn___Mobile%20Phones.:offset=0.html
https://www.newshub.co.nz/home/author-pages.html
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Spring Loaded

Introducing the new iMac,

iPad Pro, iPhone 12 in purple,

AirTag and Apple TV 4K.

Apple’s New Releases

Say hello to the new iMac.

Inspired by the best of Apple.
Seven vibrant colours.

You choose

green, yellow, orange, pink, purple, blue,

silver.

Only 11.5 mm. Now that’s thin.

This extraordinary design is only possible thanks to M1,
the first system on a chip for Mac. It makes iMac so thin
and compact that it fits in more places than ever.

M1 integrates the processor, graphics, memory and more
onto a single chip. That lets us put an entire computer into
a space so small it practically disappears.

A power connector that easily attaches via

magnets.

With a colour matched woven cable

Brilliant 4.5k Retina display

See the big picture. And all the details.

See it all in sharp, glorious detail on the immersive 24�inch 4.5K

Retina display.2 The P3 wide colour gamut brings what you’re

watching to life in over a billion colours. Images shine with a

brilliant 500 nits of brightness. An industry-leading anti-reflective

coating delivers greater comfort and readability. And True Tone

technology automatically adjusts the colour temperature of your

display to the ambient light of your environment, for a more

natural viewing experience. So whether you’re editing photos,

working on presentations, or watching your favourite shows and

movies, everything looks incredible on iMac.
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1080p FaceTime HD camera.

Ready for your close-up.

It’s the best camera system ever in a Mac. Double the

resolution for higher-quality video calls. A larger sensor

that captures more light. And the advanced image signal

processor (ISP) of M1 greatly improves image quality. So

from collaborating with co-workers to catching up with

friends and family, you’ll always look your best.

The ISP on M1 uses computational video to enhance image

quality. To capture stunning video, it goes through a series of

steps to analyse and enhance each pixel, at over a trillion

operations per second. Advanced noise reduction algorithms

bring a new level of clarity. Tone mapping delivers enhanced

dynamic range, for more detail in bright highlights and dark

shadows. And it works with the Neural Engine in M1 to make

more intelligent exposure and white balance adjustments so

you look just right in any light.

Studio-quality mics.

For high-quality conversations.
Whether you’re on a video call with a friend, cutting a

track or recording a podcast, the microphones on iMac

make sure you come through loud, crisp and clear. The

studio-quality three-mic array is designed to reduce

feedback, so conversations flow more naturally and you

interrupt each other less. And beamforming technology

helps the mics ignore background noise. Which means

everyone hears you — not what’s going on around you.

Six-speaker sound system.

Audio that really fills a room.

The sound system on iMac brings incredible, room-filling

audio to any space. Two pairs of force-cancelling

woofers create rich, deep bass without unwanted

vibrations. And each pair is balanced with a high-

performance tweeter. The result is a massive, detailed

sound stage that takes your movies, music and more to

the next level.

Thanks to the redesigned speakers and advanced

algorithms, iMac now supports spatial audio when

playing video with Dolby Atmos. And when you combine

that with the 4.5K Retina display, it’s like bringing the

whole cinema into your home.

M1 and Big Sur.
With great power comes great capability.
M1 is the most powerful chip we’ve ever made. macOS Big Sur

is the most advanced desktop operating system in the world.

Combined, they take iMac to entirely new levels of

performance, efficiency and security. iMac wakes from sleep

almost instantly, apps launch in a flash, and the whole system

feels fluid, smooth and snappy. With up to 85 per cent faster

CPU performance and up to two times faster graphics

performance than standard 21.5-inch iMac models, you can use
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apps like Xcode and Affinity Photo to compile code in a fraction

of the time or edit photos in real time. And it runs cool and

quiet even while tackling these intense workloads. That’s the

power of hardware, software and silicon — all designed

together.

That means Safari is faster than ever, and you can browse

with hundreds of tabs open at once.

You can fly through edits in Adobe Lightroom and easily

work with massive 100-megapixel images.

Even take on machine learning tasks — like quickly

transforming your photo into vector layers with

Vectornator.

There are more Apps for iMac than ever before

iPad Pro
M1 chip. 12.9-inch Liquid Retina XDR

display.2

Supercharged

by the

Apple M1 chip

iPhone 12
The fastest chip in a smartphone. 5G.4

A brighter, more colourful OLED display.

Ceramic Shield with 4x better drop

performance.5 Now. In. Purple.

iPhone 12 and iPhone 12 mini
Blast past fast.

5G speed.1 A14 Bionic, the fastest chip in a

smartphone.

An edge-to-edge OLED display. Ceramic Shield with

four times better drop performance. And Night mode

on every camera. iPhone 12 has it all — in two

perfect sizes.

Big news.

6.1”

Mini news.

5.4”

11% thinner than iPhone 11

15% smaller than iPhone 11

16% lighter than iPhone 11

Super Retina XDR display3

The world’s smallest, thinnest, lightest 5G phone.

Ceramic Shield. Clearly tougher than any

smartphone glass. 4x better drop performance2

5G speed OMGGGGG.

5G on iPhone is incredibly fast. So you can download

movies on the fly. Stream higher-quality video. Or

FaceTime in HD over a mobile network. With a lot less lag.

And you can do it in more places, because iPhone 12 has

the broadest 5G coverage worldwide.



Page 11Helping Seniors with Apple Technology http://seniormac.org.nz

H2OK
Even better spill and splash resistance4

Dual�camera system

Welcome to the dark side.

Both the Wide and Ultra Wide cameras now have Night mode

— and it’s better than ever at capturing incredible low-light

shots. The new Wide camera brings in 27 per cent more light.

So whether you take photos by day or by moonlight, you’ll get a

level of detail and colour that wasn’t possible before.

Evenings have entered the picture.

Night mode senses when light is low and kicks in automatically,

maintaining clarity while capturing beautiful vibrant color. All

you have to do is start snapping.

Deep Fusion, in mid to low light, analyses multiple exposures to

maximise detail. Check out the texture in the wood, fabric and

crystal. And the Ultra Wide camera gets you a heroic

perspective.

Automatic magic.

Smart HDR 3 balances the elements in a shot, bringing out

detail in the subject and trees while retaining the rich colour of

the sky — even at high noon.

Beyond faces, Smart HDR 3 uses

machine learning to recognise

scenes, then adjusts sharpness,

colour and white balance where

needed.

Even in bright light, Smart HDR 3

is amazing at capturing texture,

skin tone, colour saturation and

individual details that make

photos feel true to life.
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Face it. Nothing beats Portrait mode.

Portrait mode is even

better at artfully

blurring the background

to put all the focus on

your subject.

Lovely, isn't it?

Take great photos even further by choosing from six creative

lighting effects, like High-Key Light Mono, Natural Light and

Studio Light

Air Tag

Lose your knack of losing things

AirTag is a really easy way to keep track of your stuff.

Attach one to your keys, slip another in your backpack. And

just like that, they're on your radar in the Find My app,

where you can also track down your Apple devices and keep up

with friends and family.
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Ping it. Find it.

Misplacing something like your wallet

doesn't have to be a big deal when it has

AirTag attached. You can play a sound on

the built-in speaker by going to the new

Items tab in the Find My app, or say

“Hey Siri, find my wallet”. If it's hiding

nearby — like under the couch or in the

next room — just follow the sound and your

search is over.

Cold. Warm.

Warmer. Hot.
If your AirTag is nearby, your iPhone can lead you straight to it

with Precision Finding. You'll see the distance to your AirTag and

the direction to head in — all thanks to Ultra Wideband

technology.

Precision Finding compatible with:

iPhone 11

iPhone 11 Pro and iPhone 11 Pro Max

iPhone 12 and iPhone 12 mini

iPhone 12 Pro and iPhone 12 Pro Max X

Get by with a little help from

hundreds of millions of friends.

When you've left something far behind, like at the beach or

the gym, the Find My network — hundreds of millions of

iPhone, iPad and Mac devices around the world — helps track

down your AirTag. And it is designed to protect your privacy

every step of the way.

How does it work?

Your AirTag sends out a secure Bluetooth signal that can be

detected by nearby devices in the Find My network. These

devices send the location of your AirTag to iCloud — then you

can go to the Find My app and see it on a map. The whole

process is anonymous and encrypted to protect your privacy.

And it's efficient, so there�s no need to worry about battery

life or data usage.

Lost Mode makes finding things even easier.

Just like your other Apple devices, AirTag can be put into Lost

Mode. Then, when it's detected by a device in the network,

you'll automatically get a notification. You can also set it so

someone can get your contact info by tapping your AirTag with

an NFCcapable smartphone — that's the same technology that

lets people pay for things with their phones.

Privacy is built in.

Only you can see where your AirTag is. Your location data and

history are never stored on the AirTag itself. Devices that relay

the location of your AirTag also stay anonymous, and that

location data is encrypted every step of the way. So not even

Apple knows the location of your AirTag or the identity of the

device that helps find it.

AirTag is designed to discourage unwanted

tracking.

If someone else's AirTag finds its way into your stuff, your

iPhone will notice it's travelling with you and send you an alert.

After a while, if you still haven't found it, the AirTag will start

playing a sound to let you know it's there.

Of course, if you happen to be with a friend who has an AirTag,

or on a train with a whole bunch of people with AirTag, don't

worry. These alerts are triggered only when an AirTag is

separated from its owner.

Beautifully simple.
A one-tap setup instantly connects your AirTag with your iPhone

or iPad. Enter a name for your AirTag, attach it to the item you

want to track and you're good to go.

Want AirTag notifications on your Apple Watch too? No worries.

Long live the battery.

AirTag is designed to keep going for more than a year on a

standard battery you can easily replace. And your iPhone lets

you know when it's time to pop in a new one.

Splish, splash.

Let's say you've tagged your keys and — oops — drop them in

a puddle. Or they're in the path of a colossal spill. Hey, that's

okay. Your AirTag is water-resistant.

Initial it. Emoji it.

When you buy your AirTag from the Apple website or the Apple

Store app, you can have it personalised with your initials. An

emoji. Or both. It's free and easy, and it adds some fun.

See also Review on Page ???

Apple TV

A higher definition of TV.

The new Apple TV 4K brings the best of TV together with your

favourite Apple devices and services — in a powerful

experience that will transform your lounge room.
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The best shows, movies, sport and live TV.

4K High
Frame Rate
HDR for
fluid,
crisp video.

The Apple experience.

On the big screen.

A12 Bionic

brings more

performance to

your TV.

A new Siri Remote

for precise control.

The performance you’re looking for. Straight out of

the box.

All the best TV. And it shows.

Your screen runneth over. From period pieces to shows that rule

the day, Apple TV 4K has great programming from apps like

Amazon Prime Video, Netflix, Disney+ and Sky Sports Now3 —

and critically acclaimed Apple Originals from Apple TV+.4

Apple TV app.

Apple Original shows and movies from

Apple TV+. Thousands of movies to buy or rent.

It's all your TV. All in one app.

If it's happening live, it's happening here. Apple TV 4K

teams up with some of the world�s largest TV networks and

broadcasters, making it the only box you need to connect to

your TV.

Control that runs circles

around other remotes.

The new Siri Remote

brings together speed,

fluidity and precise

control with a touch-enabled clickpad.

Turn your lounge into a concert hall.

Apple TV+. Watch critically acclaimed series, compelling

dramas, groundbreaking documentaries, kids�entertainment,

comedies and more — with new Apple Originals added

every month.

Apple Fitness+.

Choose from a catalogue of workouts led by expert trainers. In-

session metrics from your Apple Watch, like heart rate and

calories burned, are shown on your big screen in real time, so

you can focus on your workout and see how you're doing.

Apple Music.

Access over 75 million songs — and music videos from the �80s

to today's top artists — all through your Apple TV 4K.

You can even sing along to your favourite songs — word

for word — with lyrics view.

Apple Arcade.

The experience of playing Apple Arcade games — from brain

teasers to magical quests to endless runners — is all too

immersive on your big screen with Apple TV 4K.

Gameplay gets more realistic with the A12 Bionic, which

powers smoother motion and greater responsiveness. Multi-

user support helps players keep track of their individual game

levels, leaderboards and invitations — and switch between

players at any time.

And you can connect more of your favourite controllers to Apple

TV 4K, including PlayStation and Xbox Wireless controllers.
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Newshub 11/5/2021

Apple AirTags are

worth the wait

Daniel Rutledge

After being rumoured for years, Apple has

finally released AirTags - wireless little

devices that can be attached to things to

stop them from being lost.

A rival to the likes of Tile and Samsung's

SmartTags, AirTags have launched with a

RRP of NZ$55 each in Aotearoa.

Do they work as well as they claim to?

What are the drawbacks?

I've been using some AirTags for the past few weeks and here

are my thoughts.

Photo credit: Newshub.

The good

Yep, AirTags work just as well as Apple claims they do.

If you already have an iPhone and have used the Find My app

before, AirTags are super easy to connect to and then use to

track your items.

And that tracking can be fun.

Getting super accurate directions on your phone to exactly

where the Tag is located has a bit of a sci-fi feel to it - I kind of

want to add sound effects to mine so it's like when Ripley is

tracking Newt in Aliens.

Immediately upon opening the package, we hid tags from each

other around the Newshub office in Auckland and then found

them using the app.

Photo credit: Newshub.

An even bigger big-screen experience.

Use AR to see Apple TV 4K.

Audio Sharing

Shhhh. It's gonna get loud. When the kids go to bed, Audio

Sharing let's you connect two sets of AirPods to your Apple TV

4K and still enjoy movies and shows — with every scream,

explosion and roar.

iPhone control

Control it all with iPhone. Good call. Convenient built-in controls

appear on your iPhone on the Lock Screen and in Control Centre

— so you can easily play, pause, fast-forward, rewind and

adjust the volume on your TV.

HomeKit

Knock, knock? Who's there? HomeKit. Get a live view of your

front door. Double-check the locks.

From the Home app on your iPhone or iPad, you can even create

a scene called “Movie Night” that turns on your TV, lowers the

blinds and dims the lights — all at once.

AirPlay

Take a look at everything you can share. With AirPlay, you can

share the latest movies, vacation photos, music and even 4K

HDR videos from your iPhone or iPad to your Apple TV 4K in

their full resolution.

Multi-user support

You get your TV. They get theirs. With multi-user support

in Control Centre, all your family members can quickly

find only the shows they want to watch. Up Next lists,

video and music collections, recommendations and more

are tailored to each of you.

Photos

Smile. Your photos are on TV. Enjoy your photos, videos and

shared albums on the big screen. Memories automatically

creates collections of your best, and Apple TV 4K lets you see

them in 4K HDR.

App Store

There's always something good on. The App Store on Apple TV

4K has something for everyone.

Thousands of top sports, fitness and kids� apps.

And, of course, a world of games.

Life is 10% what
happens to us and
90% how we react
to it.

—Dennis P. Kimbro
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Newshub19/5/2021

Review: Apple's 2021

iMac is a remarkable

combination of style and

power

Daniel Rutledge

This week, Apple releases its latest

iMac range in New Zealand.

The brightly coloured all-in-one computers now

boast a 24-inch screen with a Retina 4.5K display

and new promise of power via the M1 chip.

R
E
V
I
E
W

An orange 24-inch iMac with an Apple M1 chip. Photo credit:
Newshub.
But are they a case of style over substance? Is Apple charging too

much money for a trendy device that will only be cool for a year or so?

In New Zealand, they start at $2149, but can cost over $5000 if

you choose every top-end option possible with every accessory

and pre-installed software option available.

The new iMacs will be available to customers from this Friday,

but I was loaned one early to review. Here are my thoughts.

The good

Wow.

That's what I said when I pulled this out of the box. It's also one

of many things Newshub's Lifestyle Editor Sarah Templeton

exclaimed as she got more excited than she has over any tech

gadget I can remember opening in the office.

It really has been designed with aesthetics in mind and be

prepared for these showing up in your Instagram feeds soon,

particularly if you follow a few creative professionals.

Apple's logo on the back of the iMac screen.
Photo credit: Newshub.

If you're close to the Tag, the app will tell you what you've

named it ("keys", "jacket" etc) is "nearby". When you get within

about 10m it'll tell you how far it is exactly and in what

direction, even telling you to try going up or down a building

level.

When you're further away, you can track it on a map like you

would any location on an online map.

The AirTags can emit a sound when you want them to and as

you get close to them, satisfying haptic feedback in your phone

helps with locating them.

It's easy as, and has uses beyond finding lost stuff.

I used an AirTag with my luggage on a recent trip to Adelaide

and while on the tarmac, made sure my suitcase was in the

plane before it took off.

It's accurate enough that you can see when it's still in the

terminal and when it's out on the plane with you. You can also

check it's still on the plane when you land - which I did, but I

suspect I would have already noticed if it had fallen out.

That price is fair and the battery in them is said to last for about

a year. When it needs replacing, you can easily do so with any

CR2032 battery.

There's not a great deal more to say about AirTags.

Unlike other tech reviews, this particular item is very

uncomplicated, offering basically one feature which it excels at.

The bad

If you don't own other Apple products, these are off-limits to you.

Android users can help identify lost tags and get them back to their

owner, but you need the Find My app to own and use AirTags.

While the prices of AirTags are totally reasonable, what their

accessories cost is a bit on the nose. You can't attach a plain

Tag to your keys, you need it in a holder that can work as a

keyring - and Apple branded ones cost more than the AirTag

itself on the company's NZ website.

There are third-party versions available for much cheaper, so

shop around if you want to save some money.

There is also the possibility of misusing AirTags, like using

them to track people without their consent.

Apple has of course implemented safeguards to prevent this

from happening, but there are concerns it's still possible. A

report that tested the stalking capabilities of AirTags on the
Washington Post found Apple's efforts to stop the misuse of its

trackers just aren't sufficient".

But the possible misuse of them by creeps shouldn't really

dissuade normal people from wanting to use them in the right way.

The verdict

Apple's AirTags do what they say on the tin and do it very well.

They're a simple device whose usability has been simplified in

the extreme for iPhone users, making it remarkably easy to set

them up and use how you like.

It's a shame they can't be used by non Apple customers and

that the Apple-branded accessories for them are quite

expensive.

But for iPhone users who tend to lose things, like their keys or

wallet, these are easily recommendable as a great buy.

Newshub was supplied Apple AirTags for this review.

https://www.washingtonpost.com/technology/2021/05/05/apple-airtags-stalking/
https://www.washingtonpost.com/technology/2021/05/05/apple-airtags-stalking/
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The model I am using is orange - dazzling bright orange on the

back and a faded, peachy orange on the strip below the screen.

There are six other colour options: pink, purple, yellow, blue,

green and plain old silver.

The colour scheme is extended across the accessories in the

box - keyboard, mouse, trackpad, even the cords - and even to

the default desktop background when you boot it up.

The customer's chosen colour extends beyond the iMac itself to
the accessories. Photo credit: Newshub.

The iMac is also strikingly thin - the screen is 11.5mm thick and

the whole thing weighs just 4.5kg. It doesn't take up much space

and is easy to move about.

The wow factor continues after booting up, too. The Retina 4.5K

display is stunning, making watching 4K video or looking at a

high-res photo a real pleasure.

As with the M1-powered MacBooks released last year, Apple's

own silicon proves an absolute beast again.

Early benchmark tests show these new iMacs are vastly more

powerful than any previous iMac - even about 38 percent more

powerful than last year's Intel Core i7-10700K 27-inch model.

For standard day to day users, that means you'll pretty much

never have to wait for anything because of hardware. I certainly

haven't while juggling loads of apps at the same time, including

demanding ones.

It never seems to heat up or make any noise, either.

Beyond standard use, the iMacs are more than powerful enough

to carry out a lot of professional work too.

Using Final Cut Pro, I comfortably edited some 4K video content,

with other apps open that I was able to tab between with no

problems. In a demo, I saw an iMac play four tracks of 4K video

simultaneously, without dropping a frame.

Like many tech devices released since the outbreak of COVID-19

and ensuing shift to working from home, the new iMac has

beefed up video meeting capabilities.

It has the best camera, best mic system and best speakers ever

in a Mac, all intelligently adjusted on the fly by the M1 to

ensure really high quality video calls.

Although this isn't a gaming PC, it obviously handles anything

on Apple Arcade without cracking a sweat. You can easily

connect an Xbox or PlayStation controller to it too, if you want.

As someone who has predominantly used PCs over Macs,

despite being an iPhone owner, one of the most refreshing

things of the iMac is its iPhone continuity features.

If you're looking at something in Safari, Notes, or any of Apple's

apps on your phone and you're near the iMac, a little icon of

that app will pop up on its screen. You click that and it opens up

on the iMac.

Every new iMac comes with an Apple Magic Keyboard and Magic
Mouse in the box. Photo credit: Newshub.

In practice, this is exceptionally handy. It's even quicker than

AirDrop and means never emailing or Slacking yourself

anything. Just imagine starting an email on your phone while

walking back from the café then just sitting down and finishing

it on the iMac as soon as you're back at your desk.

Making everything as quick and simple as possible goes further,

too. Some of the new iMacs, including my review unit, have a

keyboard with a touch ID button that allows unlocking, but also

instant switching between profiles.

There are too many examples of this sort of convenient feature

to list and I'm discovering more all the time.

The bad

The worst thing about the new iMacs is they cannot be upgraded,

so you must really think ahead if you're looking to invest in one.

It's super powerful and you can increase storage capacity with

removable drives, but it's difficult to say how much more power

or space you may need in a few years' time.

This iMac model has four USB-C ports, two of which are
Thunderbolt. Photo credit: Newshub.

Although the iMac is light and easy to move about the house or

office should you want to, I do worry about its durability in

certain use examples Apple put forward.

Specifically, using the iMac as a smart screen in the kitchen is a

bit dangerous for my liking, given how ingredients and oils can

splash around, not to mention things being knocked off the bench.

https://www.newshub.co.nz/home/technology/2020/12/review-apple-s-m1-macbook-air-is-an-amazing-new-beginning.html
https://www.notebookcheck.net/New-24-inch-M1-Apple-iMac-destroys-every-iMac-that-ever-came-before-it-in-Geekbench-single-core-tests-with-37-gains-over-the-nearest-Intel-Core-i7-and-i9-models.539353.0.html
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There are much cheaper smart screen options around, too - this

iMac could easily be overpowered for such uses and, with more

options than one needs, where a simple tablet would suffice.

Likewise, as powerful as it is, this is not designed to be a

serious gaming machine - that's still the realm of the PC, where

powerful graphics cards can be replaced with even more power

year after year.

But of course, that's not what the iMac is going for. Just one

top-end graphics card alone would cost more than an iMac,

before you buy every other component and accessory required

to get it working.

The M1 chip is an ARM processor and apps made for its Big Sur

OS run amazingly well, while those built for Intel-based Mac

models generally run well via Rosetta 2. But some older apps

just won't work - if there's an older app you need to run on a

new iMac, check if it'll do so before you buy.

And while the bright design will be loved by many folk, some

others will hate it. I personally dig it but if I was to get really

picky, I'd want smaller bezels around the screen. They're far

from ugly, but they are fairly sizable compared to some other

screens and it might be nicer to have a smaller border.

The screen's border will have fans and detractors. Photo credit:
Newshub.

It's nice to be important

BUT
it's more important to be nice.

The verdict

Apple's new iMac is a remarkable combination of vibrant,

stylistic design and mighty power.

The eye-catching colour schemes and inability to be upgraded

mean these won't be for everyone, but it's hard to imagine a

better all-in-one computer being released this year.

Particularly for iPhone users, this is a super intuitive, easy to

use unit that is more than powerful enough to handle

everything general users would need.

If you like the look of them I'd find it hard to believe you don't

love using one. I sure do.

Newshub was supplied an iMac for this review.

Guest
Speakers

29 June 2021

Sonali Chandratilake

"What is Civil Defence and what does emergency

preparedness mean for me"

Sonali Chandratilake is a Community Resilience Coordinator in

the Christchurch Civil Defence Emergency Management Team

at Christchurch City Council. Prior to joining the team at CCC,

she was an Emergency Management Advisor at Wellington

Regional Emergency Management Office, focussing on

Community Resilience and Businesses Continuity for small to

medium sized business.

She was a team leader at Student Volunteer Army during the

Canterbury Earthquakes and since then has done her research

on the Canterbury Earthquakes. She has a passion for building

our community capability to respond and recover from and

encouraging our communities to be more cohesive.

She is a mum to two active preschool boys and loves to cook a

good feed. ��

27 July 2021

Miracle Tarawa

"Life inside GLORIAVALE"

Miracle Tarawa is the daughter of the late Hopeful Christian,

founder of the renown cult “Gloriavale”.

She, along with her large family left the sect 10 years ago.

"If at first you don't
succeed; call it—
version 1.0”
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IMPRESSIONSIMPRESSIONS
IMPRESSIONS

Newshub 21/5/2021—TELEVISIONS

Emma Brannam

The new Apple TV 4K adds Siri to the

lounge

Photo credit: Apple / Newshub.

TV nights in my household have improved of late. There's

now three of us on the sofa - me, my husband and Siri.

Apple's previous Siri remotes haven't worked in New Zealand

but the latest one does, hence our newly found fondness for

throwing commands around like couch potato kings and queens.

The only other necessary accessory is, of course, an Apple

streaming device such as the new Apple TV 4K, which I've also

been testing out, but more on that in a minute.

This new remote is easier to use than the old. For a start, it's

thicker and far less likely to be lost for days on end, which has

happened to me more than once.

The new touch enabled click pad seems very responsive and it's easy

to click, swipe or make a circular gesture on the outer ring, turning it

into a jog control to quickly find particular scenes in a show.

But back to Siri as I rather like issuing commands. It's simple to

search for things such as specific shows, music, or podcasts

and to also control smart home accessories, but my favourite

command so far has to be 'What did he just say?'

This makes whatever I'm watching skip back 15 seconds or so

to replay a scene that's been rudely interrupted by a request for

attention from the husband, children or dog.

Photo credit: Apple.

There's no accelerometer or gyroscope in the new Siri Remote

so it won't work as a motion controller for Apple TV games. A

separate compatible game controller will be needed for that.

The Siri Remote will however work as the TV's main remote as

it can control the power.

It's not essential to have an Apple TV box to access the Apple

TV app. Most smart TVs have it integrated and it's also available

on some competitor's streaming devices.

But to easily access all of Apple's services, like Apple Arcade,

and to make the most of a fancy 4K smart TV, it's definitely

beneficial to have Apple TV 4K.

If you own the previous generation Apple TV 4K, the two will

seem very similar. They look identical and share many key

features such as support for resolutions up to 2160p, Dolby

Vision and HDR10.

But the newer version does have a faster A12 Bionic chip inside,

as well as support for HDMI 2.1 and Wi-Fi 6.

It allows for high frame rate HDR up to 60fps, so videos should

play more smoothly and appear more lifelike than before. That's

useful for things like fast-action sports, non-cinematic content

and short videos.

Already the likes of Red Bull TV are streaming in high frame

rate HDR. However, it might take a while before other video

producers catch up.

Apple TV 4K enables multi user support so everyone in the

family can find their own shows.

There's also the ability to colour balance. I tried it and it used

the light sensor in my iPhone (held close to the TV screen) to

compare the TV's colour balance to industry standard specs

used by cinematographers worldwide. It then gave me the

option to adjust to get the better picture. I did.

Now if Siri can magic up some chocolate to go with my TV

viewing, life would be peachy but she's already informed me

it's outside her remit.

The new Apple TV 4K with Siri Remote is released in Aotearoa

later this month for NZ$299.

First generation Apple TV 4K owners might be content enough

with just buying the new Siri Remote, which will go on sale as

a stand-alone unit for NZ$89.

Emma was supplied an Apple TV 4K for this article.

https://www.newshub.co.nz/home/storytag.:storyTag=newshub:tag-library___st___televisions.:offset=0.html
https://www.newshub.co.nz/home/author-pages/emma-brannam.html
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“giggles”
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SeniorNet Mac

Social
&

Luncheon

27th April

It was amazing that our speaker could end his talk by hoisting

us all up off our chairs and behind them; on our feet we copied

his movements such as rising and falling slowly on tip-toe,

walking forwards and in reverse toe-to-heel along a line;

although admittedly, we just watched his wall press-ups it gave

us an idea of how a personal work routine could be simply

made and executed. But mostly we just sat and listened. Paul

Dunn had graduated with a B.Phys.Ed. from the University of

Otago and initially spent 3 years working in mental health,

eventually working for the YMCA, now with fifteen years’

experience as a trainer, latterly as manager of Health and

Fitness. His talk’s title was “The Silver Tsunami - Health and

Fitness for the Mature and Motivated”.

Paul discussed the gymnasia in both the Bishopdale and City

locations of the Christchurch YMCA (founded in Lyttelton in

1862). He noted that a gynasium was formerly seen as a very

forbidding place and only stars had personal trainers. Today the

emphasis was holistic, including the concepts of wellness and

senior fitness. He quizzed his audience on the benefits of

exercise and pointed out that mental health was one of these.

Unfortunately a number of myths persisted, such as that women

The Fitness Industry & its current trends, and

more importantly “The Silver Tsunami” – Health

and Fitness for the Mature and Motivated,

Paul Dunn

Bachelor of Physical Education—15+
years in the fitness industry—currently
H&F Manager at the Christchurch YMCA.

Raffle Prizewinners

27 April 2021

1. Ross Clendon, 2. Ann Camfield, 3. Barbara Blowes

who lifted heavy weights became bulky, nor could one tone up

on a regime of lifting light weights; the biggest myth was that

one could spot the location of reduced fat on the body.

Everyone needed a slightly different programme, but this

difference was not male/female.

In discussing which was the most popular form of exercise at

present, Paul noted that cycling and walking were still widely

enjoyed, and tracking tool technology had become more

accurate, but in 2021 the demand for virtual content was in the

highest demand, perhaps an effect of the previous year’s

COVID-19 lockdown. One example Paul mentioned was the PD

Warrior programme which had been successful in temporaily

halting or even reversing the development of some symptoms of

Parkinson’s.

The Life Fit programme for older adults, however, had a waiting

list and a low price-tag. Other popular group exercises were

Pump (aerobic style, choreographed to music), Step, Zumba,

Pilates, Yoga, and Spin (with indoor bicycles). There were over

30 classes of all types a week, most of them at Bishopdale.

Now personal trainers were popular; members were less likely

to cancel, and the trainers could stop bad habits.

In answer to a question from the floor, Paul observed that the

old adage of “no pain, no gain” was no longer accepted, and

pain was seen, on the contrary, as a limiting factor. He had

been inspired by one of his group, a 93-year old who would

swim before every class.

For more information, consult <https:www.ymcachch.org.nz>.

http://www.ymcachch.org.nz
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Raffle Prizewinners

25 May 2021

1st Helen Cox, 2nd Brian Henderson, 3rd Pat Ryan

SeniorNet Mac

Social
&

Luncheon

25th May

Helen Brockelworth

Wild animals are not our usual after-lunch

fare, but we were all absorbed by the well-

illustrated talk from Helen Brockleworth

about Orana Wild Life Park, New Zealand’s
only free range zoo, situated as it is close to Christchurch airport.

Founded by the South Island Zoological Society in 1976 after six

years’ preparatory work, there had been great changes since one

walked an animal, a new arrival, off the 'plane,' and Helen showed a

40-year old photograph of this actually happening. Many listeners

would remember the old drive-through experience. The MacLeans

Island site actually comprised 180 ha. of which just 80 ha. were open

to the public. There were 90 species, some nationally unique to

Orana, such as gorilla, some most unusual, such as “auroch” (“back-

bred” cattle with features of the extinct auroch). Moreover, since

8500 children visited annually, farm animals were important, as the

Park aimed to give visitors “close encounters”. Not a farm animal, a

giraffe could also be hand-fed.

Helen discussed the conservation work of Orana Wild Life Park,

where it had a successful record of zoo-based breeding for release

into the wild, native examples being patake (brown teal), whio (blue

duck) and of course kiwi. There were a number of tuatara and

geckos; special mention should also be made of work on the rare

orange-fronted kakariki (parakeet). Achievements with exotic species

had also been notable; there was a White Rhino Conservation

Centre, whose animals were imported from South Africa,

quarantined, then shipped on to Australia. She showed a photograph

of a herd of scimitar-horned oryx. The Park was a top breeding unit

for cheetahs. In answer to a question from the floor, Helen

acknowledged this species had been through a bottleneck bringing it

down to about twenty individuals, so the gene pool was very narrow,

bringing with it health problems which needed to be bred out as part

of the improvement programme. The fastest land mammal, which had

evolved long, thin legs and a flat, long tail for balance, the cheetah had

a decreasing population. Other species showed a great diversity, for

example emus, Tasmanian Devils, Maud Island frogs, and Canterbury

mudfish; moreover it should be recalled that the Park’s environment

could attract wild species such as the nesting bell-bird and visitors like

the royal spoonbill. And otters were coming!

It was necessary to examine how the Park had managed the COVID-19

pandemic. Obviously it could not be hibernated. The first point to make

was that all staff had been retained, each with their individual skill set.

In the absence of visitors, it had been possible to move animals and to

change feeding schedules. The partnership with Zoolife in Canada had

been particularly rewarding; webcams, manipulable by an audience,

were installed enabling animals to be viewed in Zoos and Sanctuaries

worldwide when “no-one was looking”. Gorillas watching TV had

been quite a hit. Zoolife also permitted interactive conversations with

animal scientists and naturalists around the world, especially

significant when many northern hemisphere countries were still in

lockdown.

A new fundraising plan was being implemented.. Gate income

including annual passes remained important for a registered charity, as

did gift shop expenditure, but one could also adopt an animal, leave a

bequest, and private groups could hire the grounds, and catering

facilities; there was a children’s playground and safari shuttle tours.

Nor should volunteering help be forgotten. It was planned to preserve

the open range style.

Website: <https://www.oranawildlifepark.co.nz>

See also: <zoolife.com>

https://www.oranawildlifepark.co.nz
http://zoolife.com
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TECH
TIPS 4 Tips for macOS, iPad, and

iPad OS14

iPad OS14

Courtesy Pam Doughty, AUSOM

We are all advised NOT to put files in the Bin unless we are
SURE we don't want them. However, most of us know the Bin
will not be emptied immediately and we could 'recover' a file if
necessary.

We will come to the 'recover' procedure very soon. What can

you do if you don't want to empty the Bin but you do have a file

or folder that you would like to delete immediately?

In the screenshots below I have 20 items in my Bin and I would

like to keep most of them 'just in case' but I have put a folder in

the Bin that I would like to delete immediately.

mac OS

Items in the Bin

I want to delete the folder that is selected above immediately.

Once the item is selected Right (Control)-Click to obtain the

menu shown in the next screenshot.

NOTE: I have circled the 2nd option—Put Back—choose this

option if you want to 'recover' the item.

Select Delete Immediately and you will get the following warning.

PDF files on a Mac

...Extract individual pages (see page 24 for this

process on an iPad).

This procedure was described in detail in AUSOM
News October 2016 page 34. I suggest you read that article if

you need further assistance.

Save pages from a PDF

•• Open the PDF in Preview
•• Select View>Thumbnails
•• Tap or Click on the thumbnail of your choice in the sidebar.

(Hold down Command (� ) to select multiple pages) From the

Menu Bar
•• Select Edit > Copy (or � +C)
•• Select File > New from Clipboard (or � +N)

A new Window will open with the 'name' Untitled.

Click Delete and the item will be gone—there are now only 19

items in my Bin as shown below.

Click the Markup icon to add text, various shapes and lines and

your signature to this document (if required) and email it by

clicking the Share icon. Save your new file in an appropriate

folder.
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iPad OS

Another hint for using PDF files on your iPad WITHOUT the need

to purchase an additional app.
This month I am looking at saving groups of pages from a PDF

and keeping them in appropriately named folders within Files

on my iPad.
The app I am using to copy the groups of pages from the

AUSOM News PDF is Books.

PDF files on iPad

With the PDF open in the Books app tap near the centre of the

screen to make the tool bar appear. Tap the share icon (circled

above).

Select Print. You DON'T need a printer available.

To select the pages to extract, tap the area beside
Range — it initially reads All Pages >.

Select the range by sliding the page numbers. Tap Printer

Options circled in the image below.

The pages that were selected in the previous step will be

highlighted. The magic needed to SAVE these pages rather than

send them to a printer is to use two fingers to expand the PDF

to full page.

From the Share sheet scroll down to Save to Files.

Tap the Share icon (circled above).
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Precise Object Editing...

iPad OS

...Pages on the iPad that was updated in early April 2021 has
been used for this article — similar changes have been made
to Keynote and Numbers.

The latest update to Pages for iPadOS 14 has added a feature

that has made many users very happy.
It is no longer necessary to tap tiny arrows to change the size or

location of an object. These, and other settings for an object

can be changed by entering a value using your keyboard.

When you first open the updated app you will see:

This article shows some of the changes. I suggest you experiment

for yourself.

Positioning an object

Below I added a star shape and selected it. I then selected the

Arrange tab, and tapped the area circled in the screenshot below.

The result was the following...

I found I could alter the value in the selected field by using the

small on-screen keyboard or I could tap the keyboard icon

(circled) and use a larger keyboard.
The ability to type the exact dimension or position of an object

is what Apple called 'Precise Object Editing'.

Rotating an Object

With the star selected I first tapped the value beside the Rotate

area within the Arrange tab.

Here there were even more options for refinement of the object.

Tapping the area circled in the image above gave the ability to

rotate the object in 45-degree increments.

Select the 'folder' within the Files app to store the saved PDF of

your extracted pages.

NOTE: Rename or move your files within Files to allow you to

keep copies of articles for easy access. If you need to sign or

annotate the pages save to Files, open and select Markup, and

then save or email.
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Tapping the icon circled below gives the ability to rotate 'smoothly'.

NOTE: You can still use two fingers on an object and rotate it,

as was the case before the update.

The second area I tapped is not available for EVERY shape. As I

selected a Star, it is possible to change the number of points.

Tap on the points option in the Arrange tab and then enter a

number on the keyboard provided

Selecting Objects

If you want to select more than one object it is still possible to

touch and hold one object, then tap the other objects with

another finger. Use both hands if it is easier.

The latest update gave another method. Touch and hold on an

empty area of the screen, then drag the box that appears around the

objects you want to select.

The last method of selecting objects I find the easiest. Tap one

of the objects you want to select and tap Select Objects

This will result in a hint on the screen (see below).

Tap additional objects and when finished tap Done.

Final Note: An object is any item you place on a page, including

images/photos, text boxes, shapes, tables and charts.



Page 27Helping Seniors with Apple Technology http://seniormac.org.nz

X



Page 28Helping Seniors with Apple Technology http://seniormac.org.nz

Brian the Pirate’s Tech Hu
mour

—Brian Henderson

Humour
One

BEST-SELLING COMPUTER BOOKS

1001 Arabian Bytes

20 000 PCs Under the Sea

A Call to RAMs

A Tale of Two CDs

Aesop’s Folders

Alice in Cyberland

All Quiet on the Western Font

Around the Web in 90 Days

Brave New World Wide Web

Cache-22

Cacher in the Rye

Charlotte’s Web-site

Disk Doctor Zhivago

DOS Kapital

Fall of the Mouse of User

Gates of Wrath

Gone With the Windows

Green Eggs and RAM

Jane Error

Johnny Domaine

Last of the MacIcons

Little Mouse on the Prairie

Lord Of the Files

Moby Disk

Humour

Two
VIRUSES TO BE AWARE OF

RONALD REAGAN VIRUS: Saves your data, but forgets where it is stored.

MIKE TYSON VIRUS: Quits after two bytes.

DR. JACK KEVORKIAN VIRUS: Deletes all old files.

DISNEY VIRUS: Everything in your computer goes Goofy.

PROZAC VIRUS: Screws up your RAM but your processor doesn't care.

ARNOLD SCHWARZENEGGER VIRUS: Terminates some files, leaves, but IT WILL BE BAAAAACK.

DONALD TRUMP VIRUS: Verbal diarrhea.

Moll Finders

Motherboard Goose

The Mouse of Several Cables

Netscape from Alcatraz

Of Mouse and Man

Old Man and the C-Drive

One Flew Over the Internet

ROMulus and RAMus

Silas Monitor

The Byte of the Ancient Mariner

The Cache of Monte Cristo

The Old Man and the C:\

The Pit and the Pentium

The Scarlet Font

The Three Little Gigs

The URLing

The Windows of our Discontent

The Wizard of OS

Uncle Tom’s Cache

WANS Upon a Time

War and PC

Wuthering Bytes

Zorba the Geek
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NEW TECHNOLOGY ARRIVAL CAUSES GREAT EXCITEMENT!

BOOK is a revolutionary breakthrough in technology: no wires, no electric circuits, no batteries, nothing to be

connected or switched on. It's so easy to use even a child can operate it. Compact and portable, it can be used

anywhere—even sitting in an armchair by the fire-yet it is powerful enough to hold as much information as a CD-

ROM disc.

Here's how it works: BOOK is constructed of sequentially numbered sheets of paper (recyclable), each capable of

holding thousands of bits of information. The pages are locked together with a custom-fit device called a binder,

which keeps the sheets in their correct sequence.

Opaque Paper Technology (OPT) allows manufacturers to use both sides of the sheet, doubling the information

density and cutting costs. Experts are divided on the prospects for further increases in information density; for

now, BOOKS with more information simply use more pages. Each sheet is scanned optically, registering

information directly into your brain. A flick of the finger takes you to the next sheet.

BOOK may be taken up at any time and used merely by opening it. BOOK never crashes or requires re booting,

though like other display devices it can become unusable if exposed to high ambient temperatures. The "browse"

feature allows you to move instantly to any sheet, and move forward or backward as you wish. Many come with

an "index" feature, which pinpoints the exact location of any selected information for instant retrieval.

BOOK can be stored for an almost unlimited amount of time without connecting any outside power source. Many

BOOK units may be stored together, as they cause no interference with one another, even when placed in close

proximity.

An optional "BOOKmark" accessory allows you to open BOOK to the exact place you left it in a previous session-

even if the BOOK has been closed. BOOKmarks fit universal design standards; thus, various manufacturers can

use a single BOOKmark in BOOKs.

Conversely, numerous BOOKmarkers can be used in a single BOOK if the user wants to store numerous views at

once. Only the number of pages in the BOOK limits the number.

You can also make personal notes next to BOOK text entries with an optional programming tool, the Portable

Erasable Nib Cryptic Intercommunication Language Stylus PENCILS). Portable, durable, and affordable, BOOK is

being hailed as a precursor of a new entertainment wave. Also, BOOK's appeal seems so certain that thousands

of content creators have committed to the platform and investors are reportedly flocking. Look for a flood of new

titles soon.

Humour

Three
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TECHNOLOGY LAWS...According to Murphy

Murphy's Technology Law #1:

You can never tell which way the train went by looking at the track.

Murphy's Technology Law #2:

Logic is a systematic method of coming to the wrong conclusion with confidence.

Murphy's Technology Law #3:

Technology is dominated by those who manage what they do not understand.

Murphy's Technology Law #4:

If builders built buildings the way programmers wrote programs, then the first woodpecker that came along would

destroy civilisation.

Murphy's Technology Law #5:

An expert is one who knows more and more about less and less until he/she knows absolutely everything about

nothing.

Murphy's Technology Law #6:

Tell a man there are 300 billion stars in the universe, and he'll believe you. Tell him a bench has wet paint on it,

and he'll have to touch to be sure.

Murphy's Technology Law #7:

All great discoveries are made by mistake.

Murphy's Technology Law #8:

Nothing ever gets built on schedule or within budget.

Murphy's Technology Law #9:

All's well that ends... period.

Murphy's Technology Law #10:

A meeting is an event at which minutes are kept and hours are lost.

Murphy's Technology Law #11:

The first myth of management is that it exists.

Murphy's Technology Law #12:

A failure will not appear until a unit has passed final inspection.

Murphy's Technology Law #13: New systems generate new problems.

Murphy's Technology Law #14:

To err is human, but to really foul things up requires a computer.

Murphy's Technology Law #15:

We don't know one-millionth of one percent about anything.

Murphy's Technology Law #16: Any given program, when running, is obsolete.

Murphy's Technology Law #17:

A computer makes as many mistakes in two seconds as 20 men working 20 years make.


